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Pathfinder 使用手册 

1 软件介绍 

Pathfinder 是基础出口为主体和人类运动的模拟器。为分析者提供二维和

三维的可视化图形界面来设计和实施对真实情况的模拟。 

1.1 图形用户界（GUI） 

Pathfinder 的图形用户界面主要用于创建和执行模拟的模型。图 1-1 就是图

形界面的截图。截图所展示的是荷兰阿尔克马尔的一个剧院。模型由 Van 

Hooft Adviesburo 创建。更精确讲图片只是用来创建剧院几何结构的一个

dxf 文件。这个模型中包括了 2177 个观众。 

 

图 1-1 

Pathfinder 同时还拥有一个专门为高效实现可视化三维时间变化的场景的
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设计程序。三维设计结果如图 1-2 所示。在这个图中，观众聚集在使用电

梯前的安全区域。同时使用透明的方式可以观察众人在防火层的情况。 

 

图 1-2 

除了三维的可视化程序之外，Pathfinder 同样可以输出一个二维时间轴数

据文件（文件是 CSV 格式，由逗号分隔符分割）以及一个房间清空时间和

走廊流量比率的文字汇总。图 1-3 展示一个随时间变化的图表。这个图表

展示了观众在避难区的数量和在建筑物里边的总人数。 
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图 1-3 

 

1.2 模型展示 

为了匹配一个建筑模型的真实规模，模型的可通行区域用三维的三角

形网格区域来划分。这些可通行网格可通过人工输入也可以由导入的

数据自动划分（例如 FDS 几何数据文件）。 

墙和其他不可通过的区域在导航网格中展示为缺口。这些区域在模拟

器中是不可以通过的，但是也需要暗中展示出来，因为人员在没有创

建导航网格的区域是不可以进入的。 

门被创建为一个特殊的导航网格边界。在所有的模拟中，门提供进入

房间和记录人流的途径。基于在模拟器中的特殊功能，门可以准确的

控制人流。 

楼梯在导航网格中也被设计为特殊的边界和三角形。人流的速度在这
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里会变为根据楼梯斜率确定的速度。每个楼梯隐性的决定着两个门的

作用，这两个门的作用跟模拟器的其他门差不多，但是要编辑者要注

意这两个门是通过楼梯来链接的，所以不要出现几何错误导致门与楼

梯无法连接。 

电梯会被使用者叫到某一层。电梯模型要素包括有容量，上行，下客

楼层和银行里可以乘组的电梯。 

 

 

图 1-4 

每个人员都被定位为某个位置、特定的大小、速度和定义一个该人员

的行动目的。行动可以被描述为，举个例子一个人员可能会在某个位

置等待特定的时间，然后走向电梯。该人员就会被在运动网格中展示

为在一个上升的圆筒，该运动使用基于主体的技术逆转向。每个人员

都单独计算运动速度。 
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1.3 模拟模型 

Pathfinder 支持两种模拟模型。一种是“指导（Steering）”模式，待疏

散人员使用指导系统来行动和其他人员交互。该模型试着最大限度去

模拟人类行为和运动。SFPE 模型使用一系列的假设和在 Engineering 

Guide to Human Behavior in Fire 中定义的手算模式。在 SFPE 模式中待

疏散人员无需考虑避免和其他人员相撞，但是门会限制人流最大值以

及速度是由人流密度来控制的。 

使用者可以在 Pathfinder GUI 中自由切换两种模式，通过比较来得到答

案。 

1.4 局限性和不足之处 

Pathfinder 目前不支持在消防模型中整体化的模拟结果或者是对复杂

的行为提供支持，比如对于一个家庭组。 

只是部分支持动态的几何模型。（比如支持电梯，自动扶梯和门的开关，

但是不支持火车和其他运动的物体） 

电梯仅支持在紧急疏散情况，不支持普通的使用。 

1.5 系统要求 

对系统要求取决于所要模拟的模型类型。下边通过一个举例来说明，

两个模型的运行环境如下： 

Win8 64 位操作系统、Intel i7 2.6G 处理器、8GB 内存、NVIDIA NVS5200M

显卡。 

第一个模型是在一个房间中包括由 50000 名受困者，并且不包括任何

导入的几何模型。第二个是通过导入由 Revit 设计的相对复杂的模型来创

建 Pathfinder 模型，并且包括 3000 名受困者。如图 1-5 所示。 

表格 1-1 展示了两个模型的比较。模型的主要参数是参与者的人数以

及模型的复杂度，模型的复杂度由以下几点决定，在 Pathfinder 模型中的

导航网格的三角形数量和通过 Revit 模型导入的基本体数量。第一个模型

只有 4 个三角形，得到的结论就是显示的性能主要由所绘制的人数决定。

而 Revit 模型由 21480 个导航网格三角形，但是由 1300000 个 Revit 几何结
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构三角形。 

测试结果显示 50000 个受困者的模型耗时 18 分钟，但由 3000 受困者

的 Revit 模拟耗时 5 分钟。图形刷新频率是第一个模型 15 帧每秒，第二个

模型是 5 帧每秒。当 Pathfinder 导航网格显示了，Revit 模型才刚相应。 

 

 

图 1-5 

 

表格 1-1 

 Pathfinder 运行的最小系统要求： 

 32 或 64 位 Windows XP 系统，或者更高 

 等同于 Intel i5 处理性能的处理器 

 4GB 内存 

 支持 OpenGL 1.2 的图形处理器 

普通表现的系统建议配置： 
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 64 位 Windows 7 或者更高 

 Intel i7-3770（3.4GHz，4Cores） 

 8GB 内存 

 支持 OpenGL 3.2 并且支持大型 Revit 模型的显卡 

Revit 模型可以挖掘出更大的显卡性能。我们发现中等的游戏显卡

GeForce GTX 570/Radeon HD 7870，对 Revit 的大模型都有很好的性能

展示。 

 

2 Pathfinder 基础介绍 

Pathfinder 主要提供三种疏散模拟视图：二维图、三维图和导航图。通过这

些视图来实时展现您的模型，如果一个对象在某个视图中被添加、删除或者

选择，其他几个视图都会实时的更新。三个视图简介如下。 

 导航视图：通过分层的形式展示所有的模型对象，可以通过名字快速的

定位和修改模块。 

 3D 视图：通过三维形式展示当前模块，可以通过各种工具来展示和修

改模型。 

 2D 视图：跟三维视图类似，但他可以提供另外的网格快照和正投影视

图模型。 

 

2.1 导航视图 

导航视图可以帮助设计者快速找到模型对象。 

导航视图分为 6 个组： 

1. Imported Geometry 导入几何结构项，主要用于存

放导入的图形、FDS、PyroSim 或者 DXF 模型。这

些结构不会对模拟产生影响，但是会帮助使用者

分析结果。他们也可以被用来拓展空间。 

2. Profiles，可以通过 Edit Profiles 对话框来设置已经

创建的参与者的资料。 

3. Behaviors，用来定义参与人员的行为方式。 

4. Occupants，包含了该模型中的所有参与人员，如
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果使用工具来一次添加不止一个参与者，软件就会创建一个子目录。 

5. Elevators，包括了模型中的所有电梯。 

6. Floor，用来设计模型中的楼层，包括每个楼层中的所需几何结构，例如

自由活动区域，房间，楼梯，斜坡，门以及出口。 

导航视图上方的按钮介绍： 

 选择自动按钮，当一个对象在二维或者三维图中被选中时，该按钮可

以自动展开所选择的对象在导航视图中的分组。 

 全部折叠按钮，将导航视图所有分组折叠。 

 全部展开按钮，将导航视图所有分组展开，包括子分组。 

导航栏上方的 Floor 下拉框主要用于管理楼层。当选中某层时，该层所有房

间，楼梯，斜坡和门会被加入到该楼层组。当改变楼层是，所选择的楼层信

息会被展示，其他未选中的就会被隐藏。所以，Floor 下拉框实现了模型中 Z

轴属性。同时任何一个对象或者一组对象可以通过鼠标右击文本菜单来修改

是否显示。这样可以实现同时显示两层楼，通常在创建楼梯时会用到。 

2.2 3D 和 2D 视图 

图 2-1 展示了在 Pathfinder 中绘制 3D 和 2D 图形的主窗口。两个视图都包含

绘制逃生几何结构和导航的工具。两个视图的主要区别是，3D 视图允许从

各个方向来观察模型，然而二维视图却只能从一个方向观察，是一个正交方

向视图。另外 3D 视图没有快照网格，2D 视图有。3D 视图通过远景视角进

入 ，2D 视图通过选择 中的一个视角来进入模型。 

在主界面的上方是视角选取按钮、显示属性和导航模式按钮。在工具条下方

是属性面板，属性面板根据所选择的对象来显示。当选择一个绘制工具后，

属性面板将显示相关的属性来帮助绘图。如果没选择绘制工具，而是选择了

一个或者多个对象，面板将显示所选对象的属性。左侧的是移动、复制和绘

画工具条。主视图下方的状态栏显示当前工具的相关信息。 
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图 2-1 

2.2.1 导航 3D 视图 

在 3D 视图中可以通过轨道、漫游、全景和缩放等工具。 

3D 视图中主要的导航工具是轨道导航， ，通过左击和拖拽，模型可以围

绕中心进行旋转。通过鼠标中键的滑动可以对模型特定的点进行缩小和放大。

按住 SHIFT 键同时点击和拖拽可以平移视角，按住 ALT 键同时拖拽可以缩小

和放大视角。 

另外一个导航工具是漫游， ，可以自由的进入和走出模型。不按键的情

况下拖拽鼠标会旋转视角，所以鼠标往上视角会向上看，鼠标往左视角就会

往左看。按住 CTRL 键，拖动鼠标视角会往前或者往后在 XY 平面，按住 ALT

键视角会向上或者向下看。这种导航需要较高的曲线视角能力，但是最灵活

的导航工具，可以展示全方位的展示模型。 

还要全景和拖拽导航工具，可以上下左右，以及缩放工具，通过点击并且拖

拽实现放大和缩小。 

Pathfinder 同样可以通过 工具来选取和操作。通过右击和拖拽来使视角绕
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轨道旋转。 

 

2.2.2 2D 视图导航 

2D 视图的导航跟 3D 的类似，选择工具不仅可以通过单击来选择对象，还可

以通过右击或者中键来拖拽使视角移动，另外通过鼠标滚轮来放大和缩小。

为了使用方便拖拽和缩放工具被分别安排到两个工具中。 

2.2.3 重置视图 

在任何时候，可以通过 CTRL+R 键来重置视角，或者点击重置图标， 。这

样会使全部模型都放在当前视图里边。对于除漫游导航之外的所有导航，重

置工具都会是视角变为往 Z 轴的负坐标看。对于漫游视图，重置会使视角变

为往 Y 轴的正坐标看。 

视角也可以通过 CTRL+E 按键来重置当前所选择的对象，重置动作会放大所

选择的物体，并且通过旋转来将对象放置在视角中央。 

2.2.4 填充视图 

跟重置视图类似，可以通过 F 按键或者点击工具栏 按钮就可以查看填充

视图。填充视图和重置功能的区别在于，填充视图不改变视角，只是将选择

对象居中和通过扩大缩放来填充屏幕。 

2.2.5 在 2D 和 3D 视图中绘制图形 

在 2D 和 3D 视图中都可以绘制图形。3D 视图可以让使用者从各个角度观察

模型，但是在绘制 XY 平面时大多数工具会被限制。顶视图是完全不可以绘

制 XY 平面的，但是展示了一个可选的快照网格。可以在菜单栏 View->Edit 

snap grid spacing 中设置快照网格的尺寸，也可以通过在菜单中取消

View->Show Snap Grid 选项来关掉快照网格。 

绘制图形可以在以下两种模式中进行： 

 普通模式：单击视图左侧的绘画工具。通过帮助手册中何时章节的引导
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来绘制一个对象。绘制完成后，所绘制的图形就会被选定，当前工具回

到之前的所选择的导航工具。 

 相粘模式：双击视图左侧的绘制工具。绘制完成后，绘制工具会继续保

持，可以连续绘制更多的图形。如果想取消这种模式，按下 ESC 按钮，

就会回到之前的导航工具。如果工具栏中的工具图标是绿色的点表明该

工具是粘性模式。鼠标单击图标可以关掉粘性模式，但是保持工具被选

取。 

在任何时候按下 ESC 键，都可以取消当前对象回到之前导航工具。 

对于一个工具按钮，通常由两种方法来来创建对象。一种方法是通过鼠标和

键盘来图形化的绘制对象。另外一种是通过在属性面板中输入对象的坐标，

宽度等等属性来创建对象。在属性面板的修改可以实时更新到图形的变化。

这样可以更为精确的创建对象。在创建可活动区域章节中会做详细介绍。 

2.3 视图选项 

Pathfinder 提供多种模型显示选项，并且对于导入的几何模型也可以设置。

可设置选项包括有渲染几何图形、显示主体、房间上色和设置房间的透明度。 

2.3.1 渲染选项 

在主视图上方的工具条，如图 2-2 所示，有 8 个用来渲染几何图形的按钮。 

 

图 2-2 

从右到左分别为：线框渲染，实体渲染，显示材料，显示对象轮廓，平滑光

源，显示几何结构导航，显示导入的几何结构和显示人员。 

 线框渲染：只显示导入的 3D 几何结构，该功能跟立方体渲染相排斥。

在导入的 3D 模型中，并在 2D 视图下绘制门时会经常用到。 

 实体渲染：以填充的形式显示导入的 3D 模型，为默认选项。 

 显示材料：显示导入的 3D 模型表面材料，为默认选项。 

 显示对象轮廓：显示导入 3D 模型的轮廓，类似于同时显示线框和实体。 

 平滑光源：用真实感更强烈的阴影模式来显示所有模型，该模式比较消

耗显卡资源，显示会更慢。 

 显示几何结构导航：该功能是几何结构导航的开关，并不会对其他产生
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影响。 

 显示导入的几何结构：导入的几何结构的显示开关。 

 显示人员：显示人员的开关。 

2.3.2 人员显示 

关于人员显示有几个相关设置，人员可以被简要显示为圆盘和圆柱，也可以

被显示为艺术家模型或者可以通过设置各自的资料从而被分别设置为不同

的头像。可以在菜单的 VIEW->Agents 中设置。 

2.3.3 设置房间颜色 

可以通过多种办法设置房间颜色。在菜单 View->Color Rooms 子选项中设置。

默认的选项为每个房间都设置为相同的颜色，同样也可以通过房间人员密度

来设置颜色，比如人员密度高就设置为红色，密度低就设置为蓝色。最后是

混合设置模式，在该模式下只有房间里有人时会设置为一种特定颜色，否则

就会这是为其他统一颜色。 

2.3.4 房间透明度 

在绘制模型过程中，有时候需要将房间和楼梯当做透明物体。可以通过选择

需要透明的对象，然后在属性面板中设置这些对象的透明度。透明度将会在

3D 视图中展示出来。 

2.4 用分组实现模型组织 

Pathfinder 中主要通过分组来实现组织方式。在图 2-3 所示的模型类型中的

每个模型都是不可以修改的。但是可以通过创建子分组来实现进一步的组

织管理。 
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图 2-3 

2.4.1 创建子分组 

在 Imported Geometry, Occupants, Elevators 和 Floors 这些模型中可以创建子

分组。在其他子分组中也可以创建分组。在导航栏中右击希望创建的子分组

的父分组，然后选择 New Group…或者在菜单栏中选择 Model->New Group…，

弹出的对话框中选择父分组，并且输入子分组的名称，然后点击 ok。 

2.4.2 变更分组的方法 

在任何时间都可以将一个对象从一个分组移动到另外一个分组。可以通过在

导航栏中将想要移动的对象拖拽到希望的分组中，或者右击对象选择

Change Group…。在弹出的对话框中选择新的分组。对话框仅显示可以被变

更的有效分组。然后点击 OK。 

3 创建可移动区域 

Pathfinder 是建立在创建可以供人员行走的楼层的基础上。绘制的每个导航

组件都是在楼层上可以行走的，人员可以从楼层走到门，到楼梯。障碍物在

楼层上会显示为无法行走的空洞区域。 

主要的疏散组件包括房间，房间可以理解为空楼层上由墙和门围起来的区域，

在相同的楼层跟房间连接，另外还有楼梯和斜坡，将不同楼层的房间相连，

而电梯却可以将多层楼梯相连。房间可以是多种多边形，但是在相同楼层上

房间不可以重叠。当门占领了两个房间的区域时会设计的较厚，否则就会设

计的很薄用来简单的连接起两个房间。楼梯和斜坡通常是长方形的，并且在

楼梯尾部包括了一个薄的门将相邻的两个房间连接。电梯可以是任何形状也

可以使向任何方向。 

Pathfinder 提出了 Floors 概念来组织起所有的疏散组件，将所有不同的 Z 向

组件相连。 

3.1 Floors 

Floors 是 Pathfinder 中的主要的组织方式。在最基础的级别，他们由房间，

门，楼梯，斜坡和出口来组成，同时控制了画板中大多数的工具和对导入

的几何形状进行过滤。 
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在每个 Pathfinder 模型中，必须至少有一楼层，在任何指定的时间里，只

有一层激活的楼层。在绘制导航栏中的任何对象时，不是放置在当前激活

的楼层上，就是放置在子分组的楼层上。 

在开始一个新的模型时，默认的情况下 Z=0 的平面会有一个新的楼层，其

他的楼层会通过绘制几何形状来自动创建，或者通过手工来创建。此外，

新的导航组件在绘制时就会自动分类到合适的楼层中。 

3.1.1 自动创建楼层 

当没有选择任何模型时，Floor Creation 显示为图 1-3。该控制面板用来自动

创建楼层和自动安顺序将新对象归集到楼层。 

 

图 3-1 

 Auto sort egress components-如果勾选该选项，在创建或者修改导航组

件时会自动排列到合适的楼层中；如果不勾选该选项，新创建的导航组

件会被放置在 New Egress Components 中，直到手动变更到其他组中。 

 Automatically create floors-如果勾选该选项，在创建导航组件时就会自

动创建楼层。 

 Floor height-该选项用来设置自动创建的楼层的层高。如果从，将导航组

件创建到或者移动到至少有当前层高的楼层，新楼层会创建几倍的层高。 

 Group-如果 Auto sort egress components 没有勾选，新创建的导航组件

可以通过下拉框选择楼层。 

通过一个场景场景来展示对象是如何被自动排序并且自动归集到相应的楼

层，如图 3-2 所示： 

1) 新建一个模型。楼层高度默认设置为 3 米。 

2) 在 Z=0 米绘制“Room00”，该房间会被自动归集到“Floor 0.0m”。 

3) 在 Z=1.5 米绘制“Room01”, 该房间会被自动归集到“Floor 0.0m”。 

4) 绘制用来连接“Room00”和“Room01”的楼梯“Stair01”，楼梯

会自动归集到“Floor 0.0m”。 

5) 在 Z=-1.5 米绘制“Room02”，系统会自动创建“Floor -3.0m”，

“Room02”会归集到其中。 
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6) 绘制用来连接“Room00”和“Room02”的楼梯“Stair02”，楼梯

会自动归集到“Floor -3.0m”。 

7) 在 Z=7.5 米绘制“Room03”，系统会自动创建“Floor 6m”，“Room03”

会归集到其中。 

 

图 3-2 

 通过实例可以看到，当房间和楼梯创建后，楼层才会自动创建，并且会按

照楼层顺序来自动归集到合适的楼层中。 

3.1.2 对存在的模块使用自动归集 

可以通过以下操作来实现楼层的自动创建： 

1) 打开一个模型。 

2) 不选择任何对象，以便于看到 Floor Creation 面板，如果 3-1 所示。 

3) 确保勾选创建和排序相关选项，并且设置当前楼层层高。 

4) 选择所有需要归集的组件。 

5) 右击所选择组件的区域，在弹出的快捷菜单中选择 Sort Into Floors。 

6) 所有需要的楼层会被自动创建，并且所有选择的组件会被归集到

相应的楼层。 

3.1.3  手工创建楼层 

同样楼层也可以通过手工方式创建。可以在导航栏中点击下拉框，选择<Add 

New…>，如图 3-3 所示。点击后会打开一个询问楼层设置高度的对话框，输

入 Z 平面的位置或者在 3D、2D 视图视图中点击一个位置，然后点击 OK。

当激活新建的楼层时，Z 平面会被用来更新在 Z 位置的绘图工具。默认情况

下，楼层会命名为“Floor x”x 表示工作平面的层高。如果在对话框中选中
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“Set as active floor”，在创建后就会是当前激活的楼层。如果选择了“Resort 

existing egress components into new floor”，那么当前所有的组件都会移动新

建的楼层。 

 

图 3-3 

 

3.1.4 更改活动楼层 

可以通过图 3-3 中导航栏的下拉框来选择当前活动楼层。选择一个楼层后，

其他变为非活动楼层。 

当活动楼层变更后，模型会发生以下变更： 

 活动楼层中的所有对象分组和所有人员都变为可视状态。 

 其他楼层的对象分组和人员会被隐藏。 

 房间的工作平面和墙的撤销工具将被设置为活动楼层的工作平面。 

 非活动楼层的导入的几何结构会被剪切掉，只留下活动楼层层高范围

内的几何结构。 

3.1.5 显示所有楼层 

在图 3-3 中导航栏的下拉框中选择<Show All>。这样会显示所有楼层中的人

员和楼层组里边的所有子对象，同样会使导入过滤设置变为全部楼层组合

的进行。 
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3.1.6 楼层属性设置 

首先选中您需要修改属性的楼层。楼层属性面板如图 3-4 所示，包括楼层名

称，楼层工作高度，Z 轴导入 3D 几何结构的过滤显示设置。同时显示楼层

的一些统计信息，包括面积、人数（Pers）和人的密度。 

 

图 3-4 

Working Z 属性用来控制新绘制的房间和墙所添加的平面。 

Z Min 和 Z Max 用来控制 3D 几何图形的可视范围，所有低于 Z min 和高于 Z 

max 的都会被裁剪。Z Min 可以设置为 Z 轴坐标，或者是特定的一个值

CURR_FLOOR。如果设置为 CURR_FLOOR，当工作层下方还要楼层时，裁剪

平面就是设置为当前工作 Z 轴的位置，如果下方没有楼层，裁剪平面就是-

无穷大。同样 Z Max Filter 可以设置为一个固定值，也可以使用特定值，

NEXT_FLOOR。当前楼层往上的第一个楼层就是裁剪平面，如果往上没有楼

层，那裁剪平面就是+无穷大。 

3.2 房间 

房间是人员可以自由行走的区域，每个房间都由墙体来设定边界。可以绘制

多个相邻的房间，但是只有当相邻的房间有门时人员才可以在多个房间走动。

在任何时候人员只能在一个房间中走动，所以如果两个房间有重叠的部分，

那重叠部分将会从老的房间中减去，划入到新的房间。多个房间可以合并为

一个房间，也可以分割为多个区域和内部区域，分割房间通过薄的边界来实

现。所有这些特性会在下边进行讨论。 

3.2.1 增加新房间 

Pathfinder 提供了两个工具来增加新房间： 

 Polgonal Room Tool：不规则房间绘制工具 ，可以绘制复杂的有多个

顶点的房间。在模型的任意地方左击开始绘制第一个点，然后持续的点
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击左键来增加多边形的顶点。在至少设置 3 个顶点后，右击鼠标结束绘

制。或者通过面板来设置 x-y 坐标值，然后点击 Add Point 和 Close Polygon

按 钮 来 增 加 顶 点 和 结 束 绘 制 。 如 图 3-5 所 示 ：

 

图 3-5 

 Rectangular Room Tool：矩形房间绘制工具 ，通过在模型中点击两个

点，就可以简单的绘制出一个矩形房间。同样也可以通过属性面板中输

入 x-y 坐标来创建。如图 3-6 所示。 
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图 3-6 

除了新加区域的功能为，这两个工具同样可以用来在现存的几何结构上创

建凹陷区域。在已存在的区域内创建新结构同时移除任何障碍部分，然后

删除创建的模型，就成功创建了凹陷区域。该功能会在后续章节介绍，类

似餐桌，书桌等等的创建。 

3.2.2 绘制平面 

如图 3-7 所示，每个房间工具面板都需要设置 Z 平面的高度。 

 

图 3-7 

Z平面可以手工设置为特定值，或者在 2D、3D图形中通过以下步骤来设定： 

1. 选择一个房间绘制工具。 
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2. 在工具属性面板中，点击 Pick Z from Scene，点击后面板就会消失，

然后用鼠标选取一个位置。 

3. 在 3D 或者 2D 视图中选取一个点，面板会重新出现，这时 Z Plane

就会被设置为选取点的位置。 

3.2.3 Thin Walls 

工具用来添加较薄的，室内隔断或者室内分界。可以通过在模型中绘制

两个点来使用该工具，如图 3-8 所示。Pathfinder 会在这两点间尝试创建一

个室内边界线。注意：在有些情况下，Pathfinder 不能将两点连起来，如果

出现这种情况，如果出现这种情况，试着将两点限制在一个房间或者是多

个边界交叉的房间。 

 

图 3-8 

3.2.4 分割房间 

可以通过 Thin Wall 工具将一个房间可以被分割为两个或者更多。通过在房

间的边缘选取两个点，原来的房间就会被分割为两个或者更多个房间，如图

3-9 所示。 
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图 3-9 

 

需要注意的是在房间两个边缘绘制一个 Thin Wall 不会将房间分为多块，如

图 3-10 所示，在这种情况下只是简单的增加了一个薄墙。 

 

图 3-10 
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3.2.5 分割和合并房间 

除了对房间做分割操作之外，Pathfinder 有另外的两个方法来创建更为复杂

的几何结构。 

 Merge：合并命令可以将两个或更多的相邻的房间连接起来。首先

选择需要合并的相邻房间，然后在菜单选择 Model->Merge，或者右

击鼠标然后点击 Merge。 注意及时几个房间不在一个平面也可以合

并，只要他们有同一个边界。楼梯和斜坡也可以合并，但是合并后

楼梯和斜坡会失去他们各自的属性。 

 

图 3-11 

 Separate：分割命令会将房间沿着凹陷空间切割成组成部件，通过选

择希望分割的房间选择菜单的 Model->Separte 命令，或者右击点击

鼠标菜单。 
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图 3-12 

3.2.6 房间属性 

选择一个房间对象后，可以看到房间属性面板，图 3-13 所示 

 

图 3-13 

 Name：设置房间名称。 

 Visible：设置是否可视。 

 Color：设置房间颜色，不勾选将设置为默认颜色。 

 Opacity：设置透明度，当设置小于 100 时，房间后边的对象可以变

为可视。 

 X，Y，Z：房间的几何边界位置。 

 Area：房间的几何面积。 

 Pers：房间里所有人员数量。 

 Density：人员密度。 

 Speed Modifier：时间变量会影响房间人员的行动速度，人员在房间

的最大速度需要乘以改因素。举例说明可以用来体现烟雾对人员速

度的影响。Speed Modifier 设置对话框如图 3-14 所示，可以看到人
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员的初始撤离时间未变，但是在前 40 秒的时间斜坡因素将速度将为

最大速度的 25%。 

 

图 3-14 

3.2.7 避免 room-crossing 

在某些情况下，比如电影院的一排排座位或者在购物商城的一个个商店，这

种情况下只希望参与人员撤离房间而不是横穿房间，可以通过将所有连接房

间的门设置为 one-way 和确保指向是离开房间的方向。Pathfinder 很容易实

现该场景。避免每个门都设置一边 one-way 状态，可以通过以下步骤来实现： 

1) 选择不能横穿的房间。 

2) 右击其中一个房间，弹出菜单中选择 Make Doors Oneway… 

3) 会弹出 3-15 所示的对话框，可以选择 Exit only 或者 Enter Only，假设

所选房间里已经有设置为 one-way 的，也会通过该命令重新设置，然

后点击 OK 按钮。 

Pathfinder 会自动计算正确方向，来实现房间只能进或者只能出的设置。

另外需要注意，如果有个门是多个房间共用的，该功能就会不起左右，因

为门的方向无法定位为只出或只入。 
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图 3-15 

3.3 障碍物、Holes 

在 Pathfinder 模型中障碍物会被模型化为 holes，Holes 可以通过任意的多边

形或者厚墙来创建。 

3.3.1 绘制任意形状的障碍物（桌椅等） 

需要通过使用房间的凹陷属性，来在房间模型化一个办公室桌椅或者其他站

立的障碍物。这意味着房间房间包含的障碍物必须已经存在。可以通过 Add 

a Polygonal Room工具或者Add a Rectangular Room工具来绘制图形和确定障

碍物的区域。这样可以从旧房间中创建一个新的房间，然后将新房间删除，

在旧房间模型中留下一个洞。操作过程如图 3-16 所示。 
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图 3-16 

3.3.2 Thick Walls 

可以使用 工具在已经存在的模型中绘制矩形障碍物，在使用该工具时，

在属性面板中输入墙体厚度，然后用鼠标点击或者点击拖拽两个点，完成墙

体的绘制。按住 shift 键可以确保墙体保存水平或者垂直。如图 3-17 所示。 
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图 3-17 

3.4 门 

在 Pathfinder 中，人员只能通过门来穿过两个房间，同样模拟器要求每个人

员必须有一个路径去逃生门，并且门可以计算模拟人流的速度。同时在 SFPE

的模式下，门作为一个重要的人流控制机制。可以通过 Add a New Door 来

添加门。 

在添加门对象时，需要输入图 3-18 所列的的相关参数来确保是一个有效的

门。Max Width 用来设置门的宽度，如果不能完全显示，Pathfinder 会在您

鼠标放在门上边时，显示稍短的门。Max Depth 参数用来设置门洞的深度，

该参数表明两个房间通过门来连接处的深度，这个距离也是两个房屋可以安

装门的最大距离。 

 

图 3-18 

3.4.1 薄门 

薄门用来连接两个相邻的房间，如图 3-19 所示，在实例中添加一个门可以
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让人员从一个房间到另外一个房间。首先点击 工具，然后可以使用以下

三种办法来实现： 

 手工输入：在属性面板输入门的坐标，如果是有效的坐标，Create 

Door 就会有效状态，点击按钮就会创建宽度不超过 Max Width 的

门。对于薄门，Max Depth 会被忽略。 

 单击创建：在 2D 或者 3D 视图中移动鼠标到向创建门的位置，如

果是一个有效的位置，那么就会房间的交界上出现一个薄门的预

览。点击鼠标即可创建一个门，门宽度由 Max Width 来确定。 

 Click-drag：移动鼠标到需要创建门的位置，在房间边界点击并拖

动鼠标，在点击点和拖动点会出现一个门的预览。然后松开鼠标，

在两点之间就会创建一个门，通过此方法创建的门，会忽略属性

栏中的门属性。 

在图 3-19 的第二个图片橙色线段就是绘制的薄门。 

 

图 3-19 

3.4.2 Thick Doors 厚门、走廊 

在现实的模型中经常会用 Thick Door，尤其是在导入的 CAD 几何结构中。在

真实场景中，两个房间之间不会跟 ThinWall 一样连接，而是跟图 3-20 一样

有一定的连接深度。创建 Thick Door，首先需要点击 绘制工具，然后通过

以下三个方法的任意一个都可以创建： 

 手工输入：首先确保 Max Depth 大于或者等于两个边界之间的距

离，在属性面板中输入一个边界的位置，如果坐标是创建门的有
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效坐标，Create Door 会变为可用，点击后就会创建不大于 Max 

Width 的门。 

 单击创建：首先确保 Max Depth 大于或者等于两边界距离，然后

将光标移动到希望创建门的位置，就会出现一个门的预览。Max 

Width 设置的正负会确定门靠左还是靠右。然后单击就会创建门。 

 Click-Drag：将光标移动到一个房间边界处，点击并拖动到相应边

界的另外一个房间。在拖动过程中，会出现一个门的预览。松开

鼠标后，在两个房间的边界上就创建了一个门。通过该方法会忽

略属性面板中的属性。 

创建好的门如图 3-20 中橙色的矩形所示。 

在模拟的过程中，Thick doors 会以一个特殊的形式体现：门会分为两

个部分，每个部分都分别属于与其相连的房间。中间部分会被当做一

个薄门。需要注意的是与房间连接的区域在房间的属性中是被忽略的，

但是在实际模拟是包括的。 

 

图 3-20 

3.4.3 门属性面板 

选择一个门对象，就可以编辑门的属性，门属性面板如图 3-21 所示： 

 

图 3-21 

 Width：门的宽度，改变数值可以修改门的宽度，但是值不能超过
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房间边界的长度。 

 Flowrate：在 Simulation Parameters Dialog 中的参数会重写门的默

认参数。该选项可以设置人员通过门的最大流速 pers/t，代表每次

可以通过的人数，比如可以用设置旋转门。在截图中的 0.9pers/s

则表示在 1.1 秒内只能通过 1 一个人。 

 One-way：设置门的通过方向，单方向门，只能进或者还能出。根

据门所在的水平或者竖直位置，可以设置为+X，-X，+Y，-Y，四个

方向。 

 State：设置门的定时开启和关闭的时间。默认情况下在整个模拟

过程中所有门都是开启开启状态。可以通过点击 Edit Door State 对

话框，如图 3-22 所示，对话框中可以设置门的初始状态，也可以

设置某个时间开启和某个时间关闭的状态。在示例中，初始是 open，

t=10 秒是关闭，t=30 秒是会开启。 

 

图 3-22 

3.5 楼梯 

楼梯在 Pathfinder 中展现为一个可以直跑的台阶，可以通过两种工具创建，

一个工具可以在两个半平行边界间创建楼梯，另个一个工具可以通过增加台

阶数量，增加台阶高度等方法，直到连接到房屋边界。 

所有楼梯最基本的要求是楼梯的两头必须连接到两个房屋的边界，意味着楼

梯的顶端和低端不能有间隙，如图 3-23 所示。台阶的尺寸必须大于等于所

有人员中最大者的桡骨。 
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图 3-23 

3.5.1 两边界间的楼梯 

在已经存在的两个房间之间创建楼梯。这种楼梯会准确的连接到房间的边缘，

由于高度固定，因此楼梯的步长或者步高不能与实际情况匹配。但 Pathfinder

的模拟几何斜率不重要，重要的是属性模板中设置的步长和步高。 

在两个边界创建楼梯，首先要确保所连接的房间可视。如果两个房间不在一

个楼层，至少要手工将一个房间设置为可视。然后选择 2 点楼梯工具，

创建楼梯的属性面板如图 3-24 所示，之后就可以通过已下三种的任意一种

方法来创建： 

 手工输入参数：设置楼梯的宽度和输入楼梯的两个边界点。如果

边界点的位置设置有效，就会在视图中出现预览楼梯，然后面板

的 Create 变为可用，点击就可以创建楼梯。 

 Two-click：设置楼梯宽度，移动光标到第一个边界，会出现一个类

似薄墙模型的预览，点击鼠标设置第一个点。将光标移动到第二

个边界，就会出现一个楼梯预览。单击鼠标，就创建了楼梯。 

 Two-click with drag：在第一个边界点击并且拖拽鼠标，确定楼梯的

起点和宽度。在拖动至楼梯的第二个边界时，松开鼠标就可以创

建楼梯。 
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图 3-24 

 

图 3-25 

3.5.2 绘制单边楼梯 

另外一种方法可以通一个边界和设定号的楼梯步高和步长来创建楼梯。楼梯

的长度由预设目标或者到达另外一个房间为止。One-click 楼梯工具属性如图

3-26 所示，可由 4 种方式来介绍楼梯： 

 Step Count：楼梯的台阶数。 

 Total rise：在 Z 轴方向的总高度。 

 Total run：在 XY 平面的投影长度。 

 Total Length：楼梯的长度。 

 

图 3-26 

选择 one-point 楼梯工具， 之后就会显示属性面板。如果 Tread Rise 步

高是正值，楼梯将会从边界往上，如果是负值，楼下就会往下延生。同样

的如果 Tread Run 步长是正值，楼梯是往离开房间方向延生，如果是负值就

往房间方向延生。也可以通过按住 CTRL 键将 Tread Rise 设置为负值，按住

SHIFT 键将 Tread Run 设置为负值。有三种方法创建楼梯： 

 手工输入参数：设置楼梯宽度，步高，步长和总长度。设定楼梯

起点坐标，如果坐标有效，会出现预览楼梯，然后点击 Create 就
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可以创建楼梯。 

 Single-click：设置楼梯宽度，步高，步长和总长度。移动光标到房

屋边缘的起点，就会出现预览楼梯，单击鼠标就会创建楼梯。 

 Click-drag：设置楼梯步高，步长和总长度。然后在房间边界单击

拖动鼠标来设置起点和宽度。释放鼠标即可创建楼梯。 

 

图 3-27 

通过该方法创建的楼梯，在创建下一楼层时 Z 坐标必须要匹配到跟该楼层。

在创建下一个楼层或者房间时，Z 坐标要通过选取楼梯的顶点来确定。 

3.5.3 楼梯属性介绍 

楼梯拥有用于控制几何形状和在楼梯行走人员行为的属性。选择一个楼梯对

象后，就会出现图 3-28 所示的属性面板。 

 

图 3-28 

 Riser 和 Tread：由这两个参数来控制在模拟过程中人员的行走速度。

但在使用这两个作为初始参数创建的 one-piont 楼梯，如果之后模

拟过程中修改了参数，是不会修改楼梯形状的。 

 Length：楼梯从底部到顶端的总长度，该长度等同于楼梯水平长度

和垂直高度构成的三角形斜边长度。 
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 Top Door 和 Bottom Door：点击连接弹出图 3-29 对话框，每个门都

可以被单独的设置参数，参数包括 Width，Flowrate 和 State，这

三个参数详见门的设置参数。 

 One-way：设定楼梯是否是单向通过，如果是，设定通过方向。 

 Speed Modifier：设定随时间变化的人员速度参数，该参数跟房间

Speed Modifier 设定一样，可以参考房间设定。 

 Additional Info：点击链接显示楼梯的附加信息，例如楼梯的几何

信息例如边框，面积以及人员信息等。 

 

图 3-29 

3.6 斜坡 Ramps 

斜坡在 Pathfinder 模型中创建和展示很类似，同样也有两个隐藏的门在两个

末端，也是矩形的几何形状。同样可以通过两种工具来创建， ， 。跟

楼梯的主要区别就是斜坡不会影响上上边行走人员的速度。 

3.7 自动扶梯 

对于自动扶梯 Pathfinder 提供有限的支持，本质上就是属性稍作改动的楼梯。

可以通过以下步骤创建自动扶梯： 

1. 按照前边章节创建楼梯。 

2. 选择楼梯对象，出现楼梯属性面板如图 3-28 所示。 

3. 设置 one-way 属性。 

4. 点击 Speed Modifier 下拉框，选择 Speed Constant 如图 3-30 所示。 

5. 设置扶梯的运行速度，通过 Speed Modifier 中 Speed Constant 是以
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时间为变量的，这个通常也可以用来模拟扶梯的运行和关闭，当

然也可以输入任意值。 

 

图 3-30 

在模型视图中，扶梯和楼梯是没有区别的。 

默认情况下人员是被设定为不在扶梯行走的，该设置可以通过在人员

资料中选择 Walk on Escalators，设置后人员在扶梯的速度就变为人员

移动速度加扶梯的移动速度。 

注意点：如果关闭自动扶梯，扶梯就跟楼梯一样，就会忽略在人员属

性中的相关设置。 

3.8 电动人行道 

Pathfinder 同样支持电动人行道，创建方式与自动扶梯相似，区别在于电动

人行道的速度是在平斜坡中设置的。 

3.9 电梯 

在 egress-mode 模式下 Pathfinder 支持电梯操作，建立在遵守 Using Elevators 

In Fires 中描述的原则下。在疏散过程中遵守的基本操作总结如下： 

 每个电梯只有一个 discharge 楼层，这是模拟开始时电梯启动运行的地

方，也是电梯中乘客下客的楼层。 

 每个电梯至少有一个 pickup 楼层，上客楼层载入乘客，并运行到下客

楼层。 

 如果有乘客在距离电梯 0.5米的地方，电梯就在在该楼层 pickup乘客。 

 默认情况下电梯会按照从高到低的优先级服务；但是如果有乘客在某

层使用 called 服务，这些楼层会变为高优先级，用来模拟着火层。 

 电梯在驶向 pickup 楼层时，如果有比 pickup 更高的楼层使用高优先级

指令，那么电梯会改变计划运行到高优先级楼层。 

 一旦电梯装载了乘客，那他在驶入 discharge 楼层之前都不会装新乘客。 
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3.9.1 创建电梯 

电梯只有在以下模型创建之后才可以创建，下边步骤就是电梯的创建过程，

参考图 3-31： 

1) 在下客楼层绘制一个房间，并在房间中定义电梯的形状。 

2) 在最底层房间的的边界全部绘制上门，人员可以通过这些门进入和撤

离房间。 

3) 右击最底层房间，在右击菜单中选择 Create Elevator…，然后弹出如图

3-32 所示的 New Elevator 对话框。 

4) 在对话框中输入以下所有参数： 

a) Name – 电梯名称。 

b) Nominal Load – 规定承载人数，以下章节有较详细介绍。 

c) Elevator Geometry – 电梯的几何形状，由最初创建的底层房间决

定。 

d) Travel Direction – 设置电梯运行方向，该方向会自动标准化。注意：

电梯可以从该方向的相反方向运行。 

e) Elevator Bounds – 定义电梯可以到的最顶层和最底层。 

f) Elevator Timing – 定义电梯的运行速度，该速度可以用来计算电梯

从接客层到下客层的运行时间。 

g) Acceleration（Elevator Timing） - 可选项，加速电梯运行。 

h) Max Velocity – 电梯的最快速度。 

i) Open+Close Time – 电梯开启和关闭的时间。 

5) 点击 OK 创建电梯。 

在有些情况下，Pathfinder 会自动在已有的模型中为电梯创建空间，会将

电梯空间内的房间、门、楼梯和斜坡等自动删除，在删除之前 Pathfinder

会询问是否删除。 

为了能让人员使用电梯，人员必须在他们的行为参数中设置可以使用电梯，

这部分会在行为章节做介绍。 

注意点：时间参数可以通过选择电梯的新的计时模型来重新计时，在属性

面板中选择 Edit-》Level Data，然后在对话框中选择 Reset… 
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图 3-31 
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图 3-32 

3.9.2 展示电梯 

电梯创建后，就会显示为一系列的由“房间”和门组成透明电梯，如图 3-33

所示。每个楼层都有一个房间和一系列的门来与电梯连接。在 3D 和 2D 视

图中，每层房间的电梯的形状都跟底层的一样，在导航视图中，每个房间都

显示在电梯的底部而不是在电梯的顶部，另外门会显示在房间的下方。默认

情况下，房间根据与之相连的楼层命名，如果电梯与房间完全不相连，那么

房间就会被命名为”<Disconnected Level>”。 

 

图 3-33 

3.9.3 电梯属性介绍 

创建电梯后，可以通过选择电梯对象或者 ALT+左键来选取一个房间，属性

面板就会在图 3-34 中展示。 

 

图 3-34 

 Nominal Load – 额定承载人数，下边章节会有较详细介绍。 

 Open Delay – 电梯在某一 pickup 楼梯的最短开门时间。 
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 Close Delay – 关门的时间。 

 Discharge Floor – 疏散人员的下客楼层。 

 Floor Priority – 电梯 pickup 的优先级，默认情况为从上到下，可以通

过点击链接弹出图 3-35 所示的对话框，允许设置模拟的着火楼层。 

 Level Data – 点击Edit按钮，弹出图3-36所示的Elevator Levels对话框。 

 Delay – 从开始模拟到电梯可以装载人员的延时，该选项对下客层

无效。 

 Open+Close Time – 电梯门开启和关闭的总时间。 

 Pickup Time – 电梯从下客层到 pickup 层的时间。 

 Discharge Time – 电梯从 pickup 楼层到下客楼层的总时间。 

 Reset – 点击 Reset 按钮弹出电梯计时对话框，在对话框中允许自

动重算电梯相关时间，具体跟创建电梯时的设定的时间一样。 

 

图 3-35 
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图 3-36 

3.9.4 额定承载人数 

额定人数是当电梯满载时所承载的人数，默认情况是在电梯能够正常运行的

情况下估算出来的可以装载多少直径=45.58cm 的人员。增加或者减少额定

载荷会拉伸或者缩短乘客在楼梯中的尺寸。默认比例因子（默认为 1.0）是

有额定承载和相关承载人员的密度计算出来的，由此可以实现当人员因为胖

瘦尺寸不同时，可以做相应调整。在旋转门的模式下，门的几何形状可以实

现减少载荷（例如旋转门宽为 2.8 倍人的宽度）。需要注意计算出的电梯载

荷需要与电梯生成厂家的设计要求吻合。 

3.9.5 Connecting/Disconnecting floors 

创建一个电梯后，默认情况下是电梯会跟每层楼梯的房间通过门来连接。为

了防止在特别的楼层有人员进出电梯，可以将电梯的禁用。右击需要修改楼

层的电梯门在弹出的菜单中选择 Disable。如果想启用，同样右击门对象，

然后选择 Enable。或者右击电梯平面，选择 Disable，将该层的所有电梯门

都禁用，可以高效的实现该层电梯都不载人。 

3.9.6 电梯呼叫组 

默认情况下，每个楼层都分别设置呼叫功能。电梯可以实现呼叫分组，设置

后当其中一个被呼叫，所有组内电梯都相应并且驶向 pickup 楼层。在电梯

顶层分组中创建一个组，并且将目标电梯移动到新组中，所有组内电梯都使

用同样的呼叫设置。 

 

图 3-37 



                                   

45 

 

3.10 出口 

出口跟 thin door 类似，绘制在模型的边缘，一个出口只能在房间的一个边

界。 

出口的创建跟 thin door 类似，区别在于 thin door 必须创建在房屋的一个边

缘，而房屋的边缘不必是紧邻的两个房间。 

在模型展示中，出口会被标记为绿色，如图 3-38 所示。 

 

图 3-38 

3.11 导入文件 

Pathfinder 可以导入若干图像和几何结构文件用来绘制和自动创建房屋，可

以导入的格式包括 DXF,DWG,FDS 和 PyroSim 文件。 

3.11.1 导入图像 

点击菜单 Model->Add a Background Image…可以导入一个背景图片，点击后

出现对话框，可以导入 GIF,JPG,PNG 格式的图片。 

选择一个图片后，会弹出图 3-39 所示的对话框，这些对话框提供了缩放、

旋转和平移等功能。缩放功能可以通过选择 A、B 两点，两点间的距离就可

以进行设定。旋转功能，设置 A 到 B 点的向量（1,0,0），那么 A 到 B 的是 90
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度角，完成后图片会自动旋转。最后可以通过定位点来确定图片在 3D 空间

中的位置。 

 

图 3-39 

导入的图片会归集到导航栏的“Imported Geometry->Background Images”组，

图片可以在该组中编辑或者删除，另外任意数量的图片可以被添加到任意楼

层。 

3.11.2 导入 CAD 文件 

Pathfinder 可以完整的导入 AutoCAD 的 DXF 文件格式用来创建 DWG 文件。 

点击菜单 File->Import…选择目标文件，然后安装提示对话框一步一步进行，

如图 3-40 所示。 

1. Units：第一个提示框确认导入 CAD 文件的基本长度单位， 

2. Options：可以在导入之前设定更多的选项。在设定参数之前，Pathfinder

会尝试识别 CAD 文件中的 2D 楼层平面图和 3D 模型，以及根据检测到
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的模型结果来设定选项的默认值。 

a) Lines – 检测导入文件的绘制的线条，默认只对楼层平面图检测。 

b) Faces – 检测导入文件的表面，默认只对三维模型检测。 

c) Move geometry to Z – 勾选后导入的几何形状会移动到所设置的 Z

轴平面，默认只对二维楼层平面图有效。 

d) Flatten so geometry lies in one plane – 勾选后会将几何图形向内扩

展到 Z 坐标平面，精度可以达到 1e-9，这对于绘制在一个平面内

的实体很有帮助，会将所有平面都平展到一个平面。只对二维平

面图有效。 

e) Add a blank rectangle to obscure lower floors – 勾选后一个特定颜

色的实体矩形框会被添加到模型，添加后会将低楼层隐藏起来。

导入的矩形默认不包括在楼层提取物中。只对 2D 图形有效。 

 

图 3-40 

点击 Finish 按钮就可以导入文件。所有导入的文件会添加在导航栏的

“Imported Geometry”组。改组的结构包括模型层级，图形层级和所有分

布在图层上的实体。如果导入的 CAD 文件模型中包括线和面和一个实体同

时包含了线和面，实体就会在 Pathfinder 分割成两部分，一部分为线，一

部分为面。 

3.11.3 导入 Revit 文件 

Pathfinder 不可以直接导入 Autodesk 的 Revit 文件（RVT），可以通过以下两

种方法将 RVT 到出为 Pathfinder 可以去读的 DWG 文件。 

 Revit to DWG(direct)：从 Revit 中直接到出可以导入到 Pathfinder 中的

DWG 文件。虽然操作简单并且只要求有 Revit 工具，但是这种方法会
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丢失包括材料，文本的所有信息。该方法在 Revit Architecture 2014 中

的操作步骤如下： 

1. 在 Revit Architecture 中打开 RVT 文件。 

2. 点击 Reit 左上方的 按钮。 

3. 选择 Export->CAD Formats->DWG 文件。 

4. 在 DWG Export 对话框中选择<In session view/sheet set>。 

5. 在 Show in list 中选择 View in the Model 

6. 点击 Check None 按钮，然后在视图表格中选择 3D View。 

7. 点击 Next…按钮，并且为 DWG 文件命名。 

8. 点击 OK 创建 DWG 文件。 

9. 将文件导入到 Pathfinder 中。 

 Revit to FBX to AutoCAD to DWG:该方法需要 Revit 和 AutoCAd 软件，转

化较为复杂，但是他可以保留模型中的材料和文件坐标信息。以下是

具体步骤： 

1. 在 Revit Architecture 中选择需要转化的 RVT 文件。 

2. 点击左上方的 按钮。 

3. 选择 Export->FBX。 

4. 设定文件名后点击保存。 

5. 打开 AutoCAD 软件。 

6. 在菜单中选择 insert->Import. 

7. 选择刚到出的 FBX 文件。 

8. 弹出 FBX Import Options 对话框，以下是 FBX 导入相关选项设置： 

 Import Section：确保勾选 Objects 和 Materials 选项，灯光和摄

像在 Pathfinder 中不需要。 

 Assign Objects to Layers:可以选择其他项，但是 By Material 对

Pathfinder 是重要选项。 

 Unit Converstion:该设置会一定程度上让人误解，当 Current 

Drawing Unit 正确的情况下，FBX File Unit 会趋向于正确。不管

在 FBX file units 中展示为何种计算单位，FBX 文件的实际单位

总是 FOOT。需要输入合适的值来进行单位转化。举例来说假

如当前的单位是千米，你需要在左侧输入 1 右侧输入 304.8，

因为 1FOOT 就是 304.8 千米。 

 Block:取消勾选 insert file as block。 

9. 点击 OK 完成导入，可以能会收到关于摄像机剪切平面的告警。 

10. 将文件另存为 DWG 文件。 

11. 将 DWG 文件导入到 Pathfinder。 
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3.11.4 导入 PyroSim 和 FDS 文件 

PyroSim 和 FDS 文件都可以导入到 Pathfinder。在菜单选择 File->Import…，然

后选择 FDS 或者 PSM 文件，导入的几何图形会添加到 Imported Geometry

分组。 

如果导入的文件包含 holes，holes 将会自动从固体的障碍物中去除并且丢弃

掉。如果包括 grids，网格将会被 FDS 的要求分割，只导入 Z 面最小的网格。

如果包括 OPEN vents，通风孔将被网格面移除并丢弃。 

3.12 使用导入的数据 

对于每个导入的文件在创建导航几何图形时都会提供帮助。不同的文件类型

可以通过不同的方法来创建需要的房间、楼梯和门。对于所有类型的导入文

件都可以设置一些可视化的参数，比如颜色和每个几个组件的透明度。导入

的几何图形会按照原来的样子设置为 3D 的结果，可以清晰和快速的用图形

方式来展示数据。 

3.12.1 图像操作方法 

使用背景图片需要使用者在背景图片上绘制所有的房间，门和楼梯，因为绘

制导航几何图形会覆盖在背景图片上，所以最好将几何图形设置为透明。可

以通过选择导航组件然后在属性面板中降低透明度。如图 3-41 所示，在降

低房屋和门的透明度以后，可以看到背景图片。 

 

图 3-41 



                                   

50 

 

3.12.2 使用 3D CAD，PyroSim 和 FDS 文件 

因为 3D CAD，PyroSim 和 FDS 文件导入的都是 3D 的数据，所以可以非常有

效的而且准确的提取导航区域。通过 Extract floors 工具 可以从二维或者

三维视图中的房间提取导航区域。 

该工具的属性面板如图 3-42 所示，Max Slope 代表了人可以行走的最大范围。

只有导入的多边形才有比实际面积小的结果。Max Head Height 代表在模拟

中所有人员的最高身高，该参数用于截取高于头部的障碍物。Gap Tolerance

用于控制导入不完整数据，如果墙的高度与 Gap Tolerance 接近，Pathfinder

会在该区域增加一个 thin wall，将房屋分割以免将结果渗透到其他区域。 

 

图 3-42 

使用该工具在 2D 或者 3D 视图中抽取出一个房间，可以通过手工来输入楼

层的坐标或者在 2D 或者 3D 视图中点击点，来设置合适的参数。如果在这

个范围内没有高于头部的障碍物，也没有超过 Max Slope 中规定的斜坡角度，

的情况下，Pathfinder 会从这个点所在的导入的几何多边形开始匹配，直到

匹配到房间的边界。同样也会根据 Max Head Height 来截取房间的高度，如

图 3-43 所示。 

 

图 3-43 

在使用 3D 楼层抽取工具是，Pathfinder 将会包括所有导入的几何图形的表
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面即便是隐藏的。如果在抽取是必须要排除某个对象，在抽取之前的设置导

入导入对象属性时，在属性面板中取消 Include in room extraction 的选择。 

3.12.3 使用 2D DXFs 数据 

可以通过两种方法使用 2D DXF 数据： 一种方法可以作为绘制房间的向导类

似于往背景图片中添加好处；另外一种应用是从与之类似导入的 3D 图形中

自动抽取房间。 

通过内置的绘图工具来绘制房间草图，参照 Room 章节。 

自动从 2D DXF 数据文件中抽取房屋跟从 3D DXF 文件中抽取类似，同样使用

Extract Floors 抽取工具 ，此外，用户需要使用该工具在模型中点击一个

点，一个房间就会自动抽取出来。跟 3D 文件抽取的主要区别是用户不可以

选择任何用于楼层抽取的三维面表面，而是要选则空白的区域。选取点同样

需要在二维的线条包围的范围内，这些二维线条将组成抽取房间的边界，正

因为如此所有不是房间边界的线条包括符号、标记等都会被隐藏、删除或者

排除在楼层抽取之外。通过取消勾选导入对象属性面板中的 Include in room 

extraction，可以对几何对象不进行抽取。在决定哪些导入的几何形状会被抽

取后，抽取工具将会自动排除隐藏对象和手工排除的对象。 

当确定选取点之后，点周围的二维线段从顶视图看就会投影到活动楼层的 Z

平面，这些投影线段将会用来定义房间。如果点周围的线段不能确定一个封

闭的空间如图 3-44 a 所示，抽取的房间就会越过不封闭的线条，由箱体的边

界的所有线条来组成房间，如图 3-44 b 所示。这种情况下房间的外部区域可

以通过 Thin Wall 工具从内部区域分离出来，在分离之后，外部区域就可以

删除掉。 

一旦抽取工具完成房间，房间就会在活动楼层的 Z 平面中。 
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图 3-44 

 

3.12.4 填充缺损部分 

在使用 2D 或者 3D 房间抽取工具创建好房间之后，仍然缺少门和楼梯，该

节主要介绍如何手工添加门和楼梯等。 

有个特性可以有效的帮助实现添加门，那就是门工具的内部门特性。该特性

可以自动看起来需要创建门的区域，然后在该区域创建 Thick door。可以选

择门工具按钮，如图 3-18 所示的属性面板，设置 Max Width 门的最大宽度

和 Max Depth 门的最大厚度，这些属性设置值要比设置普通门的大些。在设

置好相关属性后，将光标移动到需要创建门的地方，就会出现一个门的预览。

如果没有出现，就需要重新修改相关属性值的设置。如果出现的门没有问题，

然后点击鼠标左键，就会在该地方创建一个 Thick door。 

 

图 3-45 
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3.12.5 Flattening and Z location 

有些情况下导入的 3D CAD 模型，抽取出来的房间存在高度不合适或者存在

斜率不合适的情况。这些问题可以通过在抽取房间之前或者之后使用 Set Z

对话框来解决。具体步骤如下： 

1. 选择需要矫正的对象。 

2. 右击对象，然后选择 Set Z…。 

3. 会出现图 3-46 对话框。 

4. 设置相关值，然后点击 OK 来修改几何对象。 

 

图 3-46 

对话框的相关属性解释如下： 

 Selection Bounds：确定所选对象的最大和最小 Z 轴坐标。 

 Flatten Objects：勾选该选项后，所选择的每个对象都会被压扁到

同一平面，该平面的坐标有 Move to 选择确定。 

 Move to：该选项确定所选择对象要压缩到 Z 平面的位置，可以有

如下几个选项。 

 Absolute Z：所有选择对象都被移动到同一个 Z 平面。如果没

有勾选 Flatten objects，每个对象都会移动到所能够到的最小

的 Z 平面。 

 Z Offset：选取的每个对象都被移动到特定的 Z Distance，如果
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勾选 Flatten Objects，对象首先被压扁到最小的 Z 坐标，然后

在移动到 Z Distance。 

 Z Multiple：选取的每个对象都被移动到有 Z Offset 和 Z 

Multiplier 确 定 的 Z 坐 标 ， 具 体 定 义 如 下 ：

，n 参数定义为对象离原始

坐标最小 Z 坐标的整数。 

3.12.6 视觉特性 

导入的 2D 和 3D 几何体都有相应的视觉特性，所有几何体都有物体颜色和

透明度。由 DWG,PSM,FDS 导入的物体表面可以选择性的设置相关材料，可

以更高级的定义显示属性，例如下边将要讨论的纹理图片。如果一个表面设

置了一种材料，那么在勾选 Show Materials（ ）选项后他将覆盖对象的颜

色和透明度。 

选择几何体后就可以设置所有相关的显示属性，如图 3-47 所示。 

 

图 3-47 

 Visible：设置所选对象是否可见。 

 Include in room extraction：对房间抽取工具是否考虑该对象。 

 Material：在对象的 Show Materials 选项为 true 时，打开对象的材料属

性设置对话框，如图 3-48 所示。在对话框中可以编辑和修改物体的材

料，只要从左边的列表中选择一个材料然后点击 OK 就可以。如果要

去除材料，只要选择<No Material>即可。需要注意的是，一种材料可

以被很多表面引用，所以如果在一处修改的材料，其他所有引用到该

材料的表面也会做修改。 

 Color：在对象没有材料或者材料 Show Materials 关闭时物体的颜色。 

 Opacity：在对象没有材料或者材料 Show Materials 关闭时物体的透明

度。 
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3.12.7 材料 

材料可以用来定义导入的几何体表面属性，可以通过在 2D 和 3D 视图中选

择 Show Materials（ ）来定义是否显示表面材料。材料可以被多个表面共

用，当材料修改后，所有引用的表面都会做修改。 

对于不同导入类型的文件，材料可以通过不同的方法进行抽取，具体如下： 

 DWG：DWG 文件拥有材料的概念，每个对象所引用的材料将会被导入

到 Pathfinder。目前 Pathfinder 支持固有色贴图，纹路贴图以及材料的

透明度。 

 FDS and PSM：这两种文件中 Pathfinder 通过颜色和纹路的设置来构建

材料。 

注意：Pathfinder 中“material”的定义区别与 PyroSim 和 FDS 的定义，

在这两个文件中 Material 定义为实物的物理的属性。而在 Pathfinder

只是定义显示的颜色而已。 

如果需要查看从 DWG 和 PSM 文件导入的材料，可以通过菜单的

Model->Manage Material Database…就可以显示图 3-48 所示材料对话框。 
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图 3-48 

Pathfinder 定义了一些默认的材料数据库，这些材料都会有 psm_前缀。其

他的材料是由使用者手工创建或者从 CAD 以及 PyroSim 文件中导入。 

材料可以通过 Import…按钮来手工添加到材料列表。目前新材料必须由定

义文理的图片创建，图片会直接复制到数据库。新创建的材料会添加到数

据库，可以在整个 Pathfinder 中使用。 

导入的材料只存储在当前的 Pathfinder 文件中，对新创建的模型并不适用，

而且目前没有办法将其写入数据库中。 

材料可以通过 Remove…按钮删除，如果删除的材料是数据库中的，那么数

据库中所有关联的目录都会永久的删除。 

材料的以下属性可以被编辑： 
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 Color：该属性可将材料设置为纯色。 

 Texture Image：该属性将材料显示为文理图片。 

 Width and Height：设置模型中文理图片的大小。 

 Opacity：设置材料的透明度。 

3.12.8 重构和快速编辑 

有些情况下导入的数据文件并没有以很好的方式组织起来。例如想要修改所

有窗口的某个特性，但是这些窗口并没有在一个分组中，所以很难一次性全

部选中。在这种情况下可以选择其中一个对象，然后选择 Select All by Color，

或者 Select All by Material。这样就可以将所有同样颜色或者同样材料的对象

选中，然后一次性修改他们的共同属性。 

 

 

 

 

 


